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e “xPC Target APIs” on page 1-2

e “xPC Target API for Microsoft .NET Framework” on page 1-3
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e “xPC Target COM API” on page 1-7
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1 Introduction

xPC Target APIs

The xPC Target™ software provides several APIs that enable you to create
custom applications to control real-time applications running on target
computers.

The xPC Target software provides multiple types of xPC Target API (for
example, the xPC Target API for Microsoft® .NET Framework, xPC Target C,
and xPC Target COM). These interfaces provide the same functionality for
you to write custom solutions (for example, client target applications and
batch runs) that use the xPC Target software. The xPC Target documentation
collectively refers to these APIs as xPC Target API.

The xPC Target APIs allow you to:

® Establish communication between the host computer and the target
computer via an Ethernet or serial connection

¢ Load the target application, a .d1m file, to the target computer

® Run that application on the target computer

® Monitor the behavior of the target application on the target computer

e Stop that application on the target computer

¢ Unload the target application from the target computer

¢ (Close the connection to the target computer
The following sections describe each library:

¢ “xPC Target API for Microsoft .NET Framework” on page 1-3
e “xPC Target C API” on page 1-5
o “xPC Target COM API” on page 1-7



xPC Target™ API for Microsoft® .NET Framework

xPC Target API for Microsoft .NET Framework

The xPC Target API for Microsoft .NET Framework consists of objects
arranged in hierarchical order. Each of these objects has methods and
properties that allow you to manipulate and interact with it. The API provides
a number of classes, including those for target applications, scopes, the file
system, and the target computer. The xPCTargetPC class is the main class
that sits on top of a hierarchy of classes. This document presents the API
reference. You can use these API functions from languages and applications
that support managed code.

The Microsoft Windows® API supplies the infrastructure for using threads.
The xPC Target API for Microsoft .NET Framework builds on top of that
infrastructure to provide a programming model that includes asynchronous
support. You do not need prior knowledge of threads programming to use
this API.

The xPC Target .NET object model closely models the xPC Target system.
One xPCTargetPC Class object represents one xPC Target system.

An xPCApplication Class object represents the target application. It
contains xPCSignals, xPCParameters, and xPC*Logger objects. These objects
respectively represent the signals, parameters, and logs available in the
target application.

An xPCFileSystem Class object represents the entire xPC Target file system.
It contains objects like the following:

¢ xPCDrivelnfo, which represents a volume drive that the target computer
recognizes.

¢ xPCDirectoryInfo, which represents a target computer folder item.

¢ xPCFilelnfo, which represents a target computer file item.

The following graphic outlines the xPCTargetPC hierarchy.
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xPC Target™ C API

xPC Target C API

The xPC Target C API consists of a series of C functions that you can call from
a C or C++ application. This API is designed for multi-threaded operation.
The xPC Target C API DLL consists of C functions that you can incorporate
into a high-level language application. A user can use an application written
through either interface to load, run, and monitor an xPC Target application
without interacting with MATLAB®. With the xPC Target C API, you write
the application in a high-level language (such as C, C++, or Java®) that
works with an xPC Target application; this option requires that you are an
experienced programmer.

The xpcapi.dll file contains the xPC Target C API dynamic link library,
which contains over 90 functions you can use to access the target application.
Because xpcapi.dll is a dynamic link library, your program can use run-time
linking rather than static linking at compile time. Accessing the xPC Target C
API DLL is beneficial when you are building applications using development
environments such as Microsoft Foundation Class Library/Active Template
Library (MFC/ATL), DLL, Win32 (non-MFS) program and DLL, and console
programs integrating with third-party product APIs (for example, Altia®).

All custom xPC Target C API applications must link with the xpcapi.dll
file (xPC API DLL). Also associated with the dynamic link library is the
xpcinitfree.c file. This file contains functions that load and unload the xPC
Target C API. You must build this file along with the custom xPC Target C
API application.

The xPC Target C API consists of blocking functions. For communications
between the host and target computer, a default timeout of 5 seconds controls
how long a target computer can take to communicate with a host computer.

The documentation reflects the fact that the API is written in the C
programming language. However, the API functions are usable from other
languages and applications, such as C++ and Java.
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Note To write a non-C application that calls functions in the xPC Target C
API library, refer to the compiler documentation for a description of how

to access functions from a library DLL. You must follow these directions to
access the xPC Target C API DLL.

1-6
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xPC Target COM API

Note The xPC Target COM API is no longer being enhanced. You should use
the xPC Target API for Microsoft .NET Framework instead. See “xPC Target
API for Microsoft NET Framework” on page 1-3

The xPC Target COM API is an open environment application program
interface designed to work with Microsoft COM and the xPC Target C API.
The COM API is not designed for multi-threaded operation.

With xPC Target COM API, you use a graphical development environment to
create a GUI that works with an xPC Target application. Designed to work
with Microsoft COM, the xPC Target COM API conforms to the component
object model standard established by Microsoft.

The xPC Target COM API is a programming layer that sits between you and
the xPC Target C API. The difference between the C API and this API is that
while the C API is a dynamic link library of C functions, the xPC Target
COM API dynamic link library is an organized collection of objects, classes,
and functions. You access this collection through a graphical development
environment such as Microsoft Visual Basic®. Using such a graphical
development environment, you can create a custom GUI application that can
work with one xPC Target application.

The xPC Target COM API library depends on xpcapi.dll, the xPC Target
dynamic link library. However, the xPC Target C API is independent of the
xPC Target COM APL.

The xPC Target COM API consists of blocking functions. For communications
between the host and target computer, a default timeout of 5 seconds controls
how long a target computer can take to communicate with a host computer.

The xPC Target COM API has the following features:
¢ A DLL component server library — xpcapicom.dll is a component server

DLL library COM interface consisting of component interfaces that
access the target computer. The COM API library enhances the built-in

1-7
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functionality of a programming language by allowing you to easily access
the xPC Target C API for rapid development of xPC Target GUI.

Built on top of the xPC Target C API — You can use the data, methods,
and structured object model hierarchy in xpcapicom.dll to interface

with an xPC Target application via an application such as Visual Basic.
xpcapicom.dll also enables search functionality and bidirectional
browsing capabilities. Generally, you view object models by selecting a type
and viewing its members. Using the xPC Target COM API library, you can
select a member and view the types to which it belongs.

Programming language independent — This section describes how to create
an xPC Target COM API application using Visual Basic. However, the xPC
Target COM API interface is not limited to this third-party product. You
can add the COM API library to development environments that can access
COM libraries, such as Visual C++® or Java, as well as scripting languages
such as Perl, Python, and Basic.

Ideal for use with Visual Basic — The xPC Target COM API works well
with Visual Basic, and extends the event-driven programming environment
of Visual Basic.



Required Products

Required Products

Refer to System Requirements for a list of the required xPC Target products.
In addition, you need the following products:

¢ Third-party Development Environment — To build a custom application
that references interfaces in the xPC Target API for the .NET Framework,
use a third-party development environment and compiler that can interact
with .NET. For example, the Windows PowerShell™, Microsoft Visual
Studio®, and the MATLAB environments.

¢ Third-Party Compiler — To build a custom application (.exe, DLL) that calls
functions from the xPC Target API libraries, use a third-party compiler that
generates code for Win32 systems. You can write client applications that
call these functions in another high-level language, such as C#, C++, or C.


http://www.mathworks.com/products/xpctarget/requirements.html

1 Introduction
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xPC Target API for
Microsoft .NET Framework

¢ “Using the xPC Target API for NET Framework” on page 2-2
e “xPC Target .NET API Object Model” on page 2-4

e “xPC Target API for .NET Framework Classes” on page 2-5

e “xPC Target .NET API Usage” on page 2-8

e “xPC Target NET API Application Deployment” on page 2-10
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Using the xPC Target API for .NET Framework

The xPC Target API for .NET framework is a fully managed .NET framework
component. Although this framework is designed to work with the Microsoft
Visual Studio software, you can use it with other development environments
that support the .NET framework. This API is a fully programmable

tool set. It contains easy-to-use components and types that enable you to
quickly design xPC Target client applications. You can use this API with a
programming language that supports .NET technology.

In this section...

“Features and Benefits” on page 2-2
“xpcosc Client Applications” on page 2-3

“File Server Browser Client Application” on page 2-3

Features and Benefits

The xPC Target API for .NET framework includes the following features
and benefits:

e Microsoft Visual Studio design time

¢ Intuitive object model (modeled after the xPC Target system environment)
¢ Simplified client model programming for asynchronous communication

with the target computer

The xPC Target .NET API provides multiple ways for you to interface client
side applications with target computers, including outside the MATLAB
environment. For example

® Visual instrumentation for your real-time application

e Custom applications to perform data observation, collection, and archiving
¢ Real-time application debugging from a remote client computer

e (Calibration, test, and evaluation of real-time processes

® Real-time data analysis
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® Batch processing and automation scripts, which can run in a shell
environment (such as PowerShell) or as a process console standalone
application (.exe file)

xpcosc Client Applications

The Simple Client Application with the .NET API example illustrates
how to use the xPC Target API for Microsoft .NET Framework to create client
applications to interface with the xpcosc model downloaded on the target
computer. This example provides two client applications:

e Examplel — Illustrates a client application that runs on the host computer.
The client application provides a GUI through which you can enter the IP
address port of the target computer with which you want to connect. It
consists of the toolbox items:

= Buttons
= TextBoxes
= TrackBar

® Example2 — In addition to the same toolbox controls as Example 1, this
example also contains a chart that displays signals from the xpcosc target
application.

File Server Browser Client Application

The API xPC Target API for the .NET Framework has the following example,
located in:

matlabroot\toolbox\rtw\targets\xpc\api\xPCFrameworkSamples\FileSystemBrowser

This example illustrates how to use the xPC Target API for the .NET
Framework to create a file browser to browse folders and files on the target
computer file system. The application resides on the host computer and
connects to the target computer to browse its file system.

This is a C# application project developed with the Microsoft Visual Studio
2008 IDE. It illustrates how to build a standalone xPC Target executable to
connect to a target computer and a host computer. See the Readme. txt file in
the example folder for instructions on how to access and build the example
code.

2-3
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xPC Target .NET APl Object Model

To develop solutions that use the xPC Target .NET API, you can interact
with the API objects in the xPC Target .NET API object model. The object
model corresponds to structure of the xPC Target environment. The object
model is hierarchical and straightforward. The following is a conceptual view
of the xPCTargetPC object.

xPC Target PC

Applications

@ Parameters

File System

Directories

¥PCTargetPC

=J[=

2-4
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xPC Target API for .NET Framework Classes

The xPC Target .NET API provides an expansive object model layer. You
should start your client model development on the following objects:

In this section...

“Mathworks.xPCTarget.Framework.xPCTargetPC” on page 2-5
“Mathworks.xPCTarget.Framework.xPCApplication” on page 2-6
“Mathworks.xPCTarget.Framework.xPCScopes” on page 2-6
“Mathworks.xPCTarget.Framework.xPCParameters” on page 2-6
“Mathworks.xPCTarget.Framework.xPCParameter” on page 2-6
“Mathworks.xPCTarget. Framework.xPCSignals” on page 2-7
“Mathworks.xPCTarget.Framework.xPCSignal” on page 2-7

“Mathworks.xPCTarget.Framework.xPCAppLogger” on page 2-7

Mathworks.xPCTarget.Framework.xPCTargetPC

The xPCTargetPC object represents the overall xPC Target environment
system. It is at the root level of the object model and exposes information
about the xPC Target session after connecting to your target computer. It
provides many class member functions that you use to access information
and manipulate its behavior.

The xPCTargetPC object principally supports a run-time user-driven mode
of execution. However, the xPCTargetPC type is also a .NET component
implementation that supports an optional developer-driven model of
execution, a design-time capability. You can integrate the design-time
capability with the Microsoft Visual Studio IDE. It supports creation and
management of the xPCTargetPC component. With this capability, you can
perform the following operations with xPCTargetPC components

® Drag and drop into the form design
® Property configuration

¢ Delete from the form design



2 rC Target™ API for Microsoft® .NET Framework

Design-time support includes a properties window in which you can configure
design-time members, code serialization, and property-editing support with
UI type editors. This supports enables you to build xPC Target application
quickly and effortlessly by dragging the component and using its functionality
as required. For more information on using Microsoft Visual Studio .NET, see
http://msdn.microsoft.com/en-us/library/aa973739(v=vs.71).aspx.

Mathworks.xPCTarget.Framework.xPCApplication

The xPCApplication object represents the xPC Target real-time application
that you generate from a Simulink® model and download to the target
computer. The xPCApplication object exposes information and properties of
the target application. It also contains members you need to:

® Access application information
¢ Manipulate application behavior

e Return other objects such as child components of the application

Mathworks.xPCTarget.Framework.xPCScopes

The xPCScopes object represents a container or place holder to access and
interface with xPC Target scopes. This object enables advanced signal data
acquisition techniques. With this object, you can access child objects related
to scopes.

Mathworks.xPCTarget.Framework.xPCParameters

The xPCParameters object represents a container or place holder to access
application parameters. You can access xPCParameter objects with this
object.

Mathworks.xPCTarget.Framework.xPCParameter

The xPCParameter object represents a specific application parameter, which
represents a run-time parameter of a specific block. With this object, you can
access information related to the block parameter. With this object, you can
also tune parameter values during simulation.


http://msdn.microsoft.com/en-us/library/aa973739(v=vs.71).aspx

xPC Target™ API for .NET Framework Classes

Mathworks.xPCTarget.Framework.xPCSignals

The xPCSignals object represents a container or place holder to access the
application signals. With this object, you can access xPCSignal objects.

Mathworks.xPCTarget.Framework.xPCSignal

The xPCSignal object represents a specific application signal, which
represents the port signal of a non-graphical block output. With this object,
you can access information related to the signal. It also allows you to monitor
signal behavior during simulation.

Mathworks.xPCTarget.Framework.xPCAppLogger

The xPCAppLogger object represents a place holder for logging objects. It
contains members that return specific logging objects.
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xPC Target .NET APl Usage

This topic presents the xPC Target API for .NET framework reference using
the C# language and the Microsoft Visual Studio environment. At a minimum:

¢ Use the xPCTargetPC component in the Visual Studio environment. This
addition provides convenient design-time features. To do this:

1 Add the xPCTargetPC component to the Visual Studio Toolbox.
2 To use this component, create a Windows application.

3 Add an xPCTargetPC object to the application form by dragging an
xPCTargetPC control from the Toolbox window to the design surface.

The xPCTargetPC control makes available in the Visual Studio
Properties window its data and appearance properties. You can click
the xPCTargetPC control in the design surface to explore and customize
the xPCTargetPC properties.

® Add a reference for xPCFramework.d11 to your project (for example, to
create a console application), include the following in your code. Doing so
enables you to access the types available from the xPC Target environment

using MathWorks.xPCTarget.FrameWork;

® To use the design-time capability of the Microsoft Visual Studio
environment, copy the xpcapi.dll file to the same folder as the application
executable. You also need this file to execute the application.

The xPC Target library has a 32-bit and a 64-bit version of the xpcapi.dll.

Note On 64-bit platforms, if you build a 64-bit target application in the
Microsoft Visual Studio environment, and want to use the xPCTargetPC
nonvisual component; place the 32-bit version of xpcapi.dll in the solution
folder and place the 64-bit version of xpcapi.dll in the application folder
that contains the .exe file. Placing the 32-bit version of xpcapi.dll in
the solution folder enables you to use the design time capabilities of the
Visual Studio environment.




xPC Target™ .NET API Usage

® Do not test communication between host and target computers
(xPCTargetPC.Ping method) until you have connected to the target
computer (xPCTargetPC.Connect method).

Note Be sure to disconnect the target computer from the host computer
before starting .NET client applications. A target computer can be
connected to only one host computer at a time. You can use xpctargetping
to verify connectivity; this function disconnects from the target computer
when done.

2-9
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xPC Target .NET APl Application Deployment

This topic describes guidelines when distributing your xPC Target API for
Microsoft NET Framework GUI application:

® You must have an xPC Target Embedded Option™ license to deploy or
distribute your GUI application.

¢ When you build your application, the Visual Studio software builds the
application files for your executable, including a *.exe file. Include these
files in the same folder when deploying or distributing your application.

e Keep in mind the relationship between the GUI application,
xPCFramework.dll, and xpcapi.dll. In particular, the GUI application
depends on xPCFramework.dll, which depends on xPCFramework.dl11.

Be sure to provide the version of xpcapi.dll (32-bit or a 64-bit) for which
your application was built.

2-10
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¢ “Using the C API” on page 3-2
¢ “Visual C Console Application” on page 3-4
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Using the C API

Keep the following guidelines in mind when you begin to write xPC Target C
API applications with the xPC Target C API DLL:

e Carefully match the function data types as documented in the function
reference. For C, the API includes a header file that matches the data types.

¢ To write a non-C application that calls functions in the xPC Target C API
library, refer to the compiler documentation for a description of how to
access functions from a library DLL. You must follow these directions to
access the xPC Target C API DLL

¢ If you want to rebuild the model (sf_car_xpc), or otherwise use the
MATLAB environment, you must have xPC Target Version 2.0 or later.
To determine the version of xPC Target you are currently using, at the
MATLAB command line, type

xpclib

This opens the xPC Target Simulink blocks library. The version of xPC
Target should be at the bottom of the window.

® You can work with xPC Target applications with either MATLAB or an
xPC Target C API application. If you are working with an xPC Target
application simultaneously with a MATLAB session interacting with
the target, keep in mind that only one application can access the target
computer at a time. To move from the MATLAB session to your application,
in the MATLAB Command Window, type

close(xpc)

This frees the connection to the target computer for use by your xPC Target
C API application. Conversely, you will need to quit your application, or do
the equivalent of calling the function xPCClosePort, to access the target
from a MATLAB session.

¢ The xPC Target C API functions that communicate with the target
computer check for timeouts during communication. If a timeout occurs,
these functions will exit with the global variable xPCError set to either
ECOMTIMEOUT (serial connections) or ETCPTIMEOUT (TCP/IP connections).
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Use the xPCGetLoadTimeOut and xPCSetLoadTimeOQut functions to get and
set the timeout values, respectively.

There are a few things that are not covered in “C API Functions” and “C API
Structures and Functions — Alphabetical List” for the individual functions,
because they are common to almost all the functions in the xPC Target C
API. These are

* Almost every function (except xPCOpenSerialPort, xPCOpenTcpIpPort,
xPCGetLastError, and xPCErrorMsg) has as one of its parameters the
integer variable port. This variable is returned by xPCOpenSerialPort and
xPCOpenTcpIpPort, and should be used to represent the communications
link with the target computer.

* Almost every function (except xPCGetLastError and xPCErrorMsg) sets a
global error value in case of error. The application obtains this value by
calling the function xPCGetLastError, and retrieves a descriptive string
about the error by using the function xPCErrorMsg. Although the actual
error values are subject to change, a zero value typically means that the
operation completed without producing an error, while a nonzero value
typically signifies an error condition. Note also that the library resets the
error value every time an API function is called; therefore, your application
should check the error status as soon as possible after a function call.

Some functions also use their return values (if applicable) to signify that
an error has occurred. In these cases as well, you can obtain the exact
error with xPCGetLastError.

3-3
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Visual C Console Application

This topic shows how to use the xPC Target C API to create a Win32 console
application written in C. You can use this example as a template to write
your own application.

In this section...

“Target Application” on page 3-4

“Folders and Files” on page 3-4

“Building the xPC Target Application” on page 3-6

“Creating a Visual C Application” on page 3-6

“Building a Visual C Application” on page 3-9

“Running an xPC Target Visual C API Application” on page 3-10
“Using the xPC Target C API Application” on page 3-10

“C Code for sf_car_xpc.c” on page 3-16

Target Application

Before you start, you should have an existing xPC Target application that
you want to load and run on a target computer. The following topics use

the target application sf_car_xpc.dlm, built from the Simulink model
sf_car_xpc, which models an automatic transmission control system. The
automatic transmission control system consists of modules that represent the
engine, transmission, and vehicle, with an additional logic block to control
the transmission ratio. User inputs to the model are in the form of throttle
(%) and brake torque (pound-foot). You can control the target application
through MATLAB with the Simulink External Mode interface, or through a
custom xPC Target C API application.

Folders and Files

This folder contains the C source of a Win32 console application that serves
as an example for using the xPC Target C API. The sf_car_xpc files are
in the folder

C:\matlabroot\toolbox\rtw\targets\xpc\api
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Filename Description

VisualBasic\Models) - Simulink model for use with xPC Target
sf_car_xpc\sf_car_xpc

VisualBasic\Models)\ - Target application compiled from Simulink
sf_car_xpc\sf_car_xpc.dlm | model

VisualC\sf_car_xpc.dsp Project file for API application
sf_car_xpc.c Source code for API application
VisualC\sf_car_xpc.exe Compiled APT application
VisualBasic\Models\ - xPC Target C API functions for supported
xpcapi.dll programming languages. Place this file in

one of the following, in order of preference:

¢ Folder from which the application is
loaded

¢ Windows system folder

The xPC Target C API files are in the folder

C:\matlabroot\toolbox\rtw\targets\xpc\api

You will need the files listed below for creating your own API application
with Microsoft Visual C++.

Filename Description

xpcapi.h Mapping of data types between xPC Target C API
and Visual C

xpcapiconst.h Symbolic constants for using scope, communication,
and data-logging functions

xpcinitfree.c C functions to upload API from xpcapi.dll

xpcapi.dll xPC Target C API functions for supported

programming languages




3 xPC Target™ AP for C

Building the xPC Target Application

These tutorials use the prebuilt xPC Target application

C:\matlabroot\toolbox\rtw\targets\
xpc\api\VisualC\sf_car_xpc.dlm

You can rebuild this application for your example:

1 Create a new folder under your MathWorks® folder. For example,
D:\mwd\sf_car_xpc2

2 Create a Simulink model and save to this folder. For example,
sf_car_xpc2

3 Build the target application with Simulink Coder™ and Microsoft Visual
C++. The target application file sf_car_xpc2.d1lm is created.

Using Another C/C++ Compiler

These tutorials describe how to create and build C applications using
Microsoft Visual C++. However, to build an xPC Target C API application,
you can use other C/C++ compilers, provided they are capable of generating a
Win32 application. You will need to link and compile the xPC Target C API
application along with xpcinitfree.c to generate the executable. The file
xpcinitfree.c contains the definitions for the files in the xPC Target C
API and is located at

C:\matlabroot\toolbox\rtw\targets\xpc\api

Creating a Visual C Application

This tutorial describes how to create a Visual C application. It is assumed
that you know how to write C applications. Of particular note when writing
xPC Target C API applications,

e (Call the function xPCInitAPI at the start of the application to load the
functions.

¢ (Call the function xPCFreeAPI at the end of the application to free the
memory allocated to the functions.
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To create a C application with a program such as Microsoft Visual C++,

1 From the previous tutorial, change folder to the new folder. This is your
working folder. For example,

D:\mwd\sf_car_xpc2

2 Copy the files xpcapi.h, xpcapi.dll, xpcapiconst.h, and xpcintfree.c
to the working folder. For example,

D:\mwd\sf_car_xpc2

3 Click the Start button, choose the All Programs option, and choose the
Microsoft Visual C++ entry. Select the Microsoft Visual C++ option.

The Microsoft Visual C++ application is displayed.
4 From the File menu, click New.
5 At the New dialog box, click the File tab.

6 In the left pane, select C++ Source File. In the right, enter the name
of the file. For example, sf_car_xpc.c. Select the folder. For example,
C:\mwd\sf_car_xpc2.

7 Click OK to create this file.

8 Enter your code in this file. For example, you can enter the contents of
sf_xpc_car.c into this file.

9 From the File menu, click New.
10 At the New dialog box, click the Projects tab.

11 In the left pane, select Win32 Console Application. On the right, enter
the name of the project. For example, sf_car_xpc. Select the working
folder from step 1. For example, C: \mwd\sf_car_xpc2.

12 To create the project, click OK.
A Win32 Console Application dialog box is displayed.

13 To create an empty project, select An empty project.
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14 Click Finish.

15 To confirm the creation of an empty project, click OK at the following
dialog box.

16 To add the C file you created in step 7, from the Project menu, select the
Add to Project option and select Files.

17 Browse for the C file you created in step 7. For example,
D:\mwd\sf_car_xpc2\sf_car_xpc.c
Click OK.

18 Browse for the xpcinitfree.c file. For example, D: \mwd\xpcinitfree.c.
Click OK.

Note The code for linking in the functions in xpcapi.dll is in the file
xpcinitfree.c. You must compile and link xpcinitfree.c with your
custom application for it to load xpcapi.dll at execution time.

19 If you did not copy the files xpcapi.h, xpcapi.dll, and xpcapiconst.h
into the working or project folder, you should either copy them now, or
also add these files to the project.

20 From the File menu, click Save Workspace.

When you are ready to build your C application, go to “Building a Visual
C Application” on page 3-9.

Placing the Target Application File in a Different Folder

The sf_car_xpc.c file assumes that the xPC Target application file
sf_car_xpc.dlmis in the same folder as sf_car_xpc.c. If you move that
target application file (sf_car_xpc.d1lm) to a new location, change the path
to this file in the API application (sf_car_xpc.c) and recompile the API
application. The relevant line in sf_car_xpc.c is in the function main(),
and looks like this:
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xPCLoadApp (port, ".", "sf_car_xpc"); checkError("LoadApp: ");

The second argument (".") in the call to xPCLoadApp is the path to
sf_car_xpc.dlm. The "." indicates that the files sf_car_xpc.dlm and
sf_car_xpc.c are in the same folder. If you move the target application,
enter its new path and rebuild the xPC Target C API application.

Building a Visual C Application

This tutorial describes how to build the Visual C application from the
previous tutorial, or to rebuild the example executable sf_car_xpc.exe,
using Microsoft Visual C++:

1 To build your own application using the xPC Target C API, copy the files
xpcapi.h, xpcapi.dll, xpcapiconst.h, and xpcinitfree.c into the
working or project folder.

2 If Microsoft Visual C++ is not already running, click the Start button,
choose the All Programs option, and choose the Microsoft Visual C++
option.

3 From the File menu, click Open.
The Open dialog box is displayed.

4 Use the browser to select the project file for the application you want to
build. For example, sf_car_xpc.dsp.

5 If a corresponding workspace file (for example, sf_car_xpc.dsw) exists for
that project, a dialog box prompts you to open that workspace instead.
Click OK.

6 Build the application for the project. From the Build menu, select either
the Build project_name.exe or Rebuild All option.

Microsoft Visual C++ creates a file named project_name.exe, where
project_name is the name of the project.

When you are ready to run your Visual C Application, go to “Running an xPC
Target Visual C API Application” on page 3-10.
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Running an xPC Target Visual C API Application

Before starting the API application sf_car_xpc.exe, verify the following:

¢ The file xpcapi.dll must either be in the same folder as the xPC Target
C API application executable, or it must be in the Windows system folder
(typically C:\windows\system or C:\winnt\system32) for global access.
The xPC Target C API application depends on this file, and will not run
if the file is not found. The same is true for other applications you write
using xPC Target C API functions.

® The compiled target application sf_car_xpc.dlm must be in the same
folder as the xPC Target C API executable. Do not move this file out of
this folder. Moving the file requires you to change the path to the target
application in the API application and recompile, as described in “Building
a Visual C Application” on page 3-9.

Using the xPC Target C API Application

To run a xPC Target C API application, you must have a working target
computer running at least xPC Target Version 2.0 (Release 13).

This tutorial assumes that you are using the xPC Target C API application
sf_car_xpc.exe that comes with xPC Target. In turn, sf_car_xpc.exe
expects that the xPC Target application is sf_car_xpc.d1lm.

If you are going to run a version of sf_car_xpc.exe that you compiled
yourself using the sf_car_xpc.c code that comes with xPC Target, you can
run that application instead. Verify the following files are in the same folder:

e sf car_xpc.exe, the xPC Target C API executable

e sf _car_xpc.dlm, the xPC Target application to be loaded to the target
computer

e xpcapi.dll, the xPC Target C API dynamic link library

If you copy this file to the Windows system folder, you do not need to
provide this file in the same folder.
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How to Run the sf car_xpc Executable

1 Create an xPC Target boot disk with a serial or network communication. If
you use serial communications, set the baud rate to 115200. Otherwise,
create the boot disk as directed in xPC Target Getting Started.

2 Start the target computer with the xPC Target boot disk.

The target computer displays messages like the following in the top
rightmost message area.

System: Host-Target Interface is RS232 (COM1/2)
or
System: Host-Target Interface is TCP/IP (Ethernet)

3 If you have downloaded target applications to the target computer through
MATLAB, in the MATLAB window, type

close(xpc)

This command disconnects MATLAB from the target computer and leaves
the target computer ready to connect to another client.

4 On the host computer, open a DOS window. Change folder to

C:\matlabroot\toolbox\rtw\targets\xpc\api\VisualC

If you are running your own version of sf_car_xpc.exe, change to the
folder that c